Content

Executive Summary

A. Projects/ Schemes Showcased by Gujarat Government

1. Department of Industries - Industrial Promotion
2. Department of Science and Technology – E-Governance
3. Department of Panchayati Raj - e-Gram Vishwagram
4. District Collectorate - Jan Sewa Kendra
5. Municipal Corporation – City Civic Centres
6. Department of Health – EMRI
7. Department of Police – Integrated Police Management System
8. Department of Planning - Flagship and Mission Mode Projects
10. BISAG

B. Key Learnings

C. Way Forward
Executive Summary

I. Department of Industries - Investment Promotion
   a) Creating conducive business environment
   b) Facilitating Industrial Infrastructure
   c) Support Infrastructure: Road, Rail and Air connectivity
   d) Support Infrastructure: Power
   e) Facilitating Industrial Infrastructure
   f) Assuring Quality Manpower
   g) Delhi Mumbai Industrial Corridor (DMIC)
   h) Vibrant Gujarat Global Investors’ Summit 2009
   i) MoU and investment monitoring mechanism
   j) Gujarat Industrial Policy 2009

II. Department of Science and Technology – E-Governance
   a) E-Governance Strategy
   b) Land Records - E-Dhara
   c) Grievance handling – SWAGAT
   d) Less Paper Secretariat Administration – IWDMS
   e) Hospital Management & Information System (HMIS)
   f) E-Procurement
Executive Summary

III. Department of Panchayati Raj - e-Gram Vishwagram
   a) Village Computer Entrepreneur (VCE)
   b) Gujarat Rural Accounting Management (GRAM)
   c) e-Governance Capacity Building Programme for PRIs BiSAG facility upto e-GRAM Panchayat
   d) Highlights of e Gram Connectivity Infrastructure Project
   e) Monthly Progressive Report of eGCI
   f) Network Architecture of eGCI Project Service Provider

IV. District Collectorate - Jan Sewa Kendra
   a) Basic Services
   b) Process
   c) Performance Highlights
   d) Impact

V. Municipal Corporation – City Civic Centres
   a) Ahmedabad Municipal Corporation
   b) Services Provided
   c) E-Governance Impact
Executive Summary

VI. Department of Health – EMRI
VII. Department of Police – Integrated Police Management System
   a) Vision
   b) Objectives
   c) Integrated IT Solutions

VIII. Department of Planning
   a) Flagship projects
      i. 30 (now 41 in 2009) Developing Talukas
      ii. Vanbandhu Kalyan Yojana
      iii. Sagarkheda Sarvangi Vikas Yojana
      iv. Garib Samruddhi Yojana
   b) Mission Mode projects
      i. Kanya Kelavani
      ii. Krishi Rath
      iii. Nirmal Gujarat
      iv. Nirogi Bal
      v. Skill Development
      vi. Livelihood
      vii. Nutrition Mission (Proposed)
Executive Summary

IX. Department of Finance – Integrated Finance Management System
   a) Stakeholders
   b) Services
   c) Other GOG Framework Integration Functions
   d) Govt. Process Re-engineering/Improvements
   e) Key Features / Benefits

X. BISAG
   a) Objectives
   b) Activities

XI. Key Learnings
   a) Effective resource mobilization
   b) Design flagship programmes and mission mode schemes
   c) Convergence
   d) Monitoring
   e) Enterprise wide IT solutions
   f) Transparent and apolitical administration
Executive Summary

IX. Way Forward

a) Detailed study of the initiatives by respective departments for replication in the state

b) Empowered committee to approve the blueprint, roadmap and design of initiatives

c) Implementation committee to ensure fast track implementation of initiatives

d) Delivery monitoring unit (DMU) to monitor the implementation

e) Regular reporting and review by Chief Secretary, Deputy. Chief Minister and Chief Minister
Department of Industries
Investment Promotion
Department of Industries and Mines

- Creating conducive business environment
- Facilitating Industrial Infrastructure
- Support Infrastructure: Road, Rail and Air connectivity
- Support Infrastructure: Power
- Facilitating Industrial Infrastructure
- Assuring Quality Manpower
- Delhi Mumbai Industrial Corridor (DMIC)
- Vibrant Gujarat Global Investors’ Summit 2009
- MoU and investment monitoring mechanism
- Gujarat Industrial Policy 2009
Conducive business environment

Simplification of procedures
- Understanding the Roadblocks in the Simplification Procedure
- Devising Mechanisms to plug in the Identified Gaps

Doing Business in Gujarat
- A compilation of various incentives offered to the investors and the clearances required to start a new venture in the State

Investor Support Software
- A software to assist in identifying suitable location based on critical parameters
- Detailed authenticated and updated information on infrastructure available upto Taluka Level

Information Bank
- Centralized availability of information about the districts, sectors, investment regions, special economic zones, etc
Conducive business environment

- **Industrial Zoning**
  - To create environmentally sustainable industrial areas based on certain predefined parameters
  - Industrial zoning will help obtain speedy clearances

- **Creation of Land Bank**
  - Identification of land for industrial purpose in each district
  - Facilitate obtaining land information and development of infrastructure which will help in planned and organised industrial development

- **SIR ACT**
  - Specific Act enacted to enable development of global hubs of economic activity supported by world class infrastructure, premium civic amenities, centers of excellence and proactive policy framework.
Facilitating Industrial Infrastructure

- 60SEZs
- Delhi Mumbai Industrial Corridor (DMIC)
- Special Investment Region (SIR)
- Multi Product
- Chemical
- Textile
- Pharma
- IT/ITES
- Electronics
- 202 Industrial Estates
- 83 Product Clusters
- Industry Area
- Petroleum, Chemicals & Petrochemical Investment Region (PCPIR)
- Gujarat International Finance Tech City (GIFT)
- Biotech
- Gems & Jewellery
- Engineering
- Knowledge Corridor
- Integrated Township

Scale of Holistic Development

Stage I
Stage II
Stage III
Stage IV

Page 12
September 2009
Support Infrastructure: Road, Rail and Air connectivity

- Airport (13)
- Highways (21,519 km)
- Railways (5,263 km)
Support Infrastructure: Power

Reforms in Power Sector

- Gujarat is projected to become a power surplus State by 2012 assuring high quality power supply
- Private sector in Gujarat contributes 25% of installed capacity
- Renewable energy sector to be the next big focus; current installed capacity of wind power is 1240 MW and is expected to reach 6400 MW by the end of FY 2020
- Transmission losses for FY 2007-08 have been 3.85%, which is amongst the lowest in the country.
- Government initiated ‘Jyoti Gram Yojana’ to supply 24 hrs electricity to all its 18,000 villages

### Power Plants in Gujarat

#### Power Plants

<table>
<thead>
<tr>
<th>Power Plants</th>
<th>No. of Plants</th>
<th>Installed Capacity (MW)</th>
<th>Share in power Generation (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal Power</td>
<td>9</td>
<td>6041</td>
<td>63.18</td>
</tr>
<tr>
<td>Gas Power</td>
<td>9</td>
<td>2182</td>
<td>22.82</td>
</tr>
<tr>
<td>Hydro Power</td>
<td>4</td>
<td>779</td>
<td>8.15</td>
</tr>
<tr>
<td>Atomic Power</td>
<td>1</td>
<td>559</td>
<td>5.85</td>
</tr>
<tr>
<td>TOTAL</td>
<td>23</td>
<td>9561</td>
<td>100</td>
</tr>
</tbody>
</table>


### Demand Projection in Gujarat (in MW)

Source: Blueprint for Infrastructure in Gujarat (BIG 2020) – Draft Final Report
Assuring Quality Manpower

India’s Premier Institutes

Knowledge

Fashion & Design

Packaging

Technology

Rural Management

Communication

Petroleum

Management

Pharmaceutical

Indian Institute of Technology

Nirma University

September 2009

Page 15
DMIC: Proposed modules in Gujarat

A high impact industrial area within 150 km distance on both sides of the Dedicated Freight Corridor (DFC), with an investment potential of US$ 90 billion.
Vibrant Gujarat Global Investors’ Summit (VGGIS) 2009 - Evolution

- Auto pilot mode
- Summit achieves model status

Platform for capturing Global Business Opportunities

2009

- Mark the beginning
- First session was successfully conducted

Establishing Gujarat as Investment Destination

2003

- Best practices repeated
- Team was built
- Constant improvement

Making Gujarat as Preferred Investment Destination

2005

- Fly wheel effect
- Partners were inducted

Making Gujarat as Most Preferred Investment Destination

2007

- Constant improvement
VGGIS, 2009 - Progressing towards Success: Proposed Investments

Investment Committed during Vibrant Gujarat Global Investors’ Summits (2003-09)

- **US$ 243 bn** in 2009
- **US$ 152 bn** in 2007
- **US$ 20 bn** in 2005
- **US$ 14 bn** in 2003

Employment potential of MoUs signed in VGGIS 09 is double than of 07

Phenomenal increase in the investments in VGGIS 2009

* US$ Exchange Rate: Rs. 50/US$
Sustaining Investment Propositions

MoU Follow up committee
- GoG has set up a mechanism for MoUs follow ups through committee headed up to the level of Chief Secretary
- Investor’s confidence is taken by these committees by addressing project implementation level issues

Investment Monitoring System
- Monitoring of the status of investment / MoU at various levels of approvals and implementation

Gujarat Investor Portal
- Tool to support Industrial Facilitation Act
- Online filing of Common Application Form (CAF) and availability of the application status online
MoU monitoring mechanism

Signing of MoUs

Details fed into IMS

Allocation to sector nodal officer (Principal Secretary)

Industries Departments

Allocation to sector nodal officer (Principal Secretary)

Guardian officer: periodic tracking

Guardian officer: periodic tracking

Guardian officer: periodic tracking

Guardian officer: periodic tracking

Guardian officer: periodic tracking

District level monitoring committee to look after MoU progress

Successful fructification of MoU

Close monitoring by CS, PS and IC
Investment Monitoring System

(1) Nodal officer creates files along with scanned copy of MOU.

(2) Intimation about MOU & Status Updates

(3) Investor may flag the issue or update status

(4) Intimation about Updates received from Investor

(5) Collector Takes District Co-ordination Meeting & Update remarks for application / issues in IMS CS takes monthly Review Meeting with Nodal & Supporting Dept. officers.

(6) Intimation of disposal of Application / Issue in YES / NO

Concerned Nodal / Guardian Officer

Supporting Depts: UDUH / Revenue etc

Collector / GM of DIC

Investor

Investor
Gujarat Industrial Policy 2009

Vision realizes in achieving three objectives:

- Investments
- Employment & Employability
- Quality

Facets of the Policy:
- SIRs
- PPP
- Mega Projects
- Innovative Projects
- Infrastructure – Plug & Play
- Port-led Development
- Logistics & Services
- SME
- Focus Sectors
- Human Resource
- Youth, Women & First-generation Entrepreneurs
- Innovation, technology & research
- Quality
- Environment
- Wealth with Social Health
- Investor Facilitation
- Policy Monitoring
Department of Science and Technology
E-Governance
Department of Science and Technology: E-Governance

- E-Governance Strategy
- Land Records - E-Dhara
- Grievance handling – SWAGAT
- Less Paper Secretariat Administration – IWDMS
- Integrated Health Management System
- E-Procurement
Key features of Gujarat E-Governance strategy

► Integrating the citizen centric delivery processes with the efficiency in internal processes within the Government

► Spending on E Governance initiatives
  ► 2% to 3% of Plan funds for each department are allocated for IT activities

  ► IT Expenditure
    ► Year 2004-05 – Rs. 39.91 crores
    ► Year 2005-06 – Rs. 72.04 crores
    ► Year 2006-07 – Rs. 97.21 crores
    ► Year 2007-08 – Rs.185.35 crores
    ► Year 2008-09 – Rs.232.60 crores

► To have a total solution provider (TSP) for turnkey basis execution in different departments
GoG Call Center

1. Operationalised during March 2008
2. Inbound Domestic Call Centre
3. Free of Cost Public-Helpdesk for inquiries related in following areas:
   a) Education (Board Exam Counseling)
   b) SCOPE (The Society for Creation of Opportunity through Proficiency in English)
   c) Election Commission related services
   d) GKS Activities
E-Dhara – Land Records Online

- E-Dhara is established to enable access and maintenance of Village Land Records in an Easy, Transparent and Secure manner.
- E-Dhara Kendras (e-DK) have been setup at Taluka Mamlatdar offices to take up day to day activities of land records such as mutations and issue of Record of Rights (RoR). Workflow based software (BhuLekh Soft) has been implemented since 2004-2005.

Objectives

- To convert physical Village Land Records into Electronic records.
- To automate maintenance and updation of Village Land Records in a secure manner.
- To set up e-Dhara Kendras (e-DKs) for accessing and updating of Land Records in a scalable manner.
- To charge user fee for self sustainable structure.
E-Dhara – Land Records Online

Land Records Information System

- Implemented in all 26 Districts, 227 Talukas covering 18,560 villages – Operational since 2005
- RoR @Village started issuing RoR from almost 5400 gram Panchayats in 200+ Talukas
- Land records computerized – i.e. 9.8 million Village Forms (VF) Nos. 7x12 and 5.6 million VF No. 8a
- Mutation carried out till June 09: 34,01,513
- Agriculture Census schedule L1,L2,L3 computerized from land records data: total data entry done: 20,00,000
- Resurvey activities initiated based on LR data : Saved lot of time and stationery by eliminating preparation of worksheets for resurvey activities
- Integration of land records with registration process is in progress. Centralized system is under development for land records
SWAGAT – State Wide Attention on public Grievance by Application of Technology

SWAGAT has been established to improve the efficiency & effectiveness of Public Grievance Redressal Mechanism in the state through improvements in the accountability standards.

Objectives

► Resolving public grievances in a time bound manner
► Enhancing public satisfaction through efficient grievance redressal and by ensuring accountability as well as transparency

Advantages

► Chief Minister holds video conferences with all the districts concerned where applicants are called one by one and the chief minister examines each complaint in detail
► The system has reduced the response time & cost of addressing grievances.
► Indirect impact in encouraging state officials to resolve grievances before they reach the SWAGAT stage
# SWAGAT

Grievances Statistics (Up to 14/07/2009)

<table>
<thead>
<tr>
<th></th>
<th>State level</th>
<th>District Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Grievances Received</td>
<td>790</td>
<td>36746</td>
</tr>
<tr>
<td>Total Grievances Redressed</td>
<td>779</td>
<td>34242</td>
</tr>
<tr>
<td>Total Complaints Pending</td>
<td>11</td>
<td>2504</td>
</tr>
</tbody>
</table>
STATUS OF "SWAGAT" PROGRAMME AT STATE LEVEL

NO. OF GRIEVANCES

SWAGAT DATES
IWDMS project has been implemented for automating the government functions and processes at all levels of the administrative hierarchy.

IWDMS provides Document Management, Workflow Management, Collaborative Environment and Knowledge Management in an integrated fashion and delivers an Electronic Workplace that result in productivity improvement in Government.

**Advantages**

► Effective, efficient and transparent administration
► Building a knowledge base consisting of various Circulars, Acts, Precedents, Document, Reports, etc, thus enabling a robust decision support system
► Helps decision making through Checklists & Access to Precedent Cases, Acts, Rules, Statutes, etc
► Automates routine tasks – Work flow / Business rules / Processes/ Reports Generation
► Traceability and accountability of actions – Audit trail
IWDMS (Towards Less Paper Governance)

Applications
- Employee Payments
- Bill Payment
- Service Matters
- Court Cases
- Human Resource
- Travel & Tour
- Office Procedures
- Workflow Management
- Knowledge Bank
- Document Repository
- Security
- Communications

Features
- Role Based Access
- Audit Trail
- Dash Board
- Feedback
- Scanner
- Collaboration
- Worklist Prioritization/Checklist
- Reports & Analysis
- Portal
- Other Govt Agencies
- Citizen Access
- Existing Systems

Infrastructural
- DigitalGov to DigitalGov Communication
- Budget
- Resource Management

Interfaces
- Interfacing

File Management
- File Creation
- File Processing
- File Approval

Page 34 September 2009
IWDMS - The Integrated Workflow and Document Management System

- Implemented since October 2005 to all secretariat departments
- Extended to HoDs in October 2006

<table>
<thead>
<tr>
<th>Category</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of Departments covered</td>
<td>25</td>
</tr>
<tr>
<td>No. of HoDs configured (Ahmedabad &amp; Gandhinagar)</td>
<td>140+</td>
</tr>
<tr>
<td>No. of core modules</td>
<td>14</td>
</tr>
<tr>
<td>No. of common modules</td>
<td>49</td>
</tr>
<tr>
<td>No. of dept. specific modules</td>
<td>300+</td>
</tr>
<tr>
<td>No. of Users (Departments + HOD)</td>
<td>11000+</td>
</tr>
<tr>
<td>Average Usage at Secretariat</td>
<td>More than 40%</td>
</tr>
<tr>
<td>Average Usage of HoDs</td>
<td>More than 7%</td>
</tr>
<tr>
<td>No. of Correspondences/letters received as on 22 June, 2009</td>
<td>1,37,000+</td>
</tr>
<tr>
<td>No. of files created as on 22 June, 2009</td>
<td>1,95,000+</td>
</tr>
<tr>
<td>No. of budget files for 2008-09</td>
<td>8900+</td>
</tr>
<tr>
<td>Knowledge base – No. of GO, GR, Circular, Acts, etc.</td>
<td>10,000+</td>
</tr>
</tbody>
</table>
## Hospital Management & Information System (HMIS)

### Patient Care Services
- Registration
- Wards
- Pharmacy
- Billing
- Patient Education
- Information Kiosk
- Nursing Care

### Clinical Services
- Clinical/EMR (Gynecology, Ophthalmic, Orthopedic, ENT, Gastro Medicine, General Medicine, Nephrology, Pediatric, Surgery, Urology, Skin etc...)
- Laboratory (Pathology, Microbiology, Bio Chemistry, Radiology)
- Blood Bank
- Imaging

### Hospital Admin
- Hospital Admin
- Human Resource
- Financial Accounting
- Stores/Inventory
- Purchase
- Transportation
- MIS Reports
- EIS Reports

### Ancillary Services
- National Programs
- Linen Management
- Equipment Maintenance
- Resource Scheduling
- Special Camp & Training
- Bio Medical Waste
- Application Security
## Coverage and Usage for HMIS as on 22 June 2009

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of Users</td>
<td>7000+</td>
</tr>
<tr>
<td>No. of Modules</td>
<td>30</td>
</tr>
<tr>
<td>Size of Database</td>
<td>2 – 3GB at each hospital. 32 GB at central server</td>
</tr>
<tr>
<td>No. of Non Teaching Hospitals covered</td>
<td>24</td>
</tr>
<tr>
<td>No. of Teaching Hospitals covered</td>
<td>6</td>
</tr>
<tr>
<td>No. of registration (Average Daily)</td>
<td>5 Teaching Major</td>
</tr>
<tr>
<td></td>
<td>24 District Hospitals = Total 29 hospitals</td>
</tr>
<tr>
<td>No. of registrations (Average Daily)</td>
<td>600 per hospital. Overall Gujarat – 18000 +</td>
</tr>
<tr>
<td>Average No. of Transactions</td>
<td>Approx 1,00,000 per hospital</td>
</tr>
<tr>
<td>No. of Users Trained</td>
<td>3200 +</td>
</tr>
</tbody>
</table>
e-Procurement

► e-Procurement is Online bidding system wherein the physical tendering activity is carried out online using the Internet and associated technologies.

► e-Procurement system is introduced for all the purchases and procurements in all the Government departments, Nigams and Societies under the administrative control of the State Government and which are funded by Government.

► Portal www.nprocure.com handles notice inviting tender to the publishing of the complete tender in the electronic form & corrigendum to filing, encryption for security and digital signing of online tenders to multistage evaluation and final conclusions.

Present Status

► From 1-1-2006 to 30-06-2009, 22700 tenders for purchase of goods/services of over Rs. 24,800 Crores have been handled.

► Departments Linked – 135

► Offices covered – 624
Department of Panchayati Raj
E-GRAM - Vishwagram Mission
Department of Panchayati Raj - e-Gram Vishwagram

▶ Village Computer Entrepreneur (VCE)
▶ Gujarat Rural Accounting Management (GRAM)
▶ e-Governance Capacity Building Programme for PRIs BiSAG facility upto e-GRAM Panchayat
▶ Highlights of e Gram Connectivity Infrastructure Project
▶ Monthly Progressive Report of Egci
▶ Network Architecture of eGCI Project Service Provider
E-GRAM - Vishwagram Mission
eGram Vishwagram

Since 2004-05, GoG under the e-GRAM Project has decided to equip all the 3 tiers of Panchayats and each and every Village Panchayat (VP) with computer hardware & software

► e-GRAM Vishwagram Society is SPV for e-governance activities for PRIs
► The Sources of funds–Grants from State and Central Government, Public Contributions

Objectives

► To develop Village Panchayat by providing necessary basic infrastructure as the delivery point of e-services of different government department
► To fulfill objectives of 73rd & 74th constitutional amendment.
► To infuse five Es in governance: ease, economy, efficiency, effectiveness & ethics
► To bridge the information and technology gap between the urban and the rural sectors
► To provide other commercial services through

Services offered

► Various Basic G2C & B2C Services
► Commenced Land Right Records from villages
► Accounting system implemented in all GPs
Computer Hardware Distribution at Gram Panchayats

<table>
<thead>
<tr>
<th>Period</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upto March 2003-04</td>
<td>700</td>
</tr>
<tr>
<td>Upto March 2004-05</td>
<td>5875</td>
</tr>
<tr>
<td>Upto March 2005-06</td>
<td>8951</td>
</tr>
<tr>
<td>Upto March 2006-07</td>
<td>12151</td>
</tr>
<tr>
<td>March-08</td>
<td>13693</td>
</tr>
</tbody>
</table>
Village Computer Entrepreneur (VCE)

- A PPP Model on a revenue sharing basis
- Local person with Min Qualification of 10th Pass
- Roll out of Basic G2C services & B2C Services through eGram Center

Technical Support & Training Service Provider (TSTSP)

- Every Month visit to each & every eGram
- Main Responsibility:
  - To Provide Technical Support (Hardware & Software) to eGram
  - To Provide Training Service to VCE
  - Assist the eGram Center in roll out of G2C Services
  - Monitoring & Implementation of new Projects like e GCI & CSC

- Regular Monthly MIS Reporting (http://pritstsp.gujarat.gov.in)
- Total 588 Technical Support Executive deployed at State, District and Taluka level
Gujarat Rural Accounting Management (GRAM)

► Prepare & Maintain Accrual Accounting System at PRIs

► Accounting period for Accrual from 1-4-2007 onwards

► Preparation of Software – Web enabled for Accrual Accounting at PRIs, enabling automation in report generation and consolidation

► Resources for Accrual Accounting of PRIs deployed by Project implementation Agency

► Gram Panchayats can account for all the line departments
e-Governance Capacity Building Programme for PRIs

- IT orientation programme given through BiSAG studio catered to VCE, Gram Mitra, Talati, TSTSP, Assistant Programmer and Nodal Officers
- Basic training provided to all VCEs and average VCEs are being re-trained by TLE
- Basic Computer Training Program of 40 hours for Talati and 20 hours for elected members of Panchayati Raj

Current Status

- Approximate 11,000 Elected Members of District Panchayats, Taluka Panchayats & Sarpanch of Village Panchayats are trained
Capacity Building Program for PRIs
BiSAG facility upto e-GRAM Panchayat

Bandwidth provided by ISRO, GOI

BiSAG Earthstation
TV studio at Gandhinagar

All DDO’s, TDO’s
7400 Gram Panchayat
Connected

One Way Video
Two Way Audio

Page 47
Highlights of e Gram Connectivity Infrastructure Project

Provided Broadband Internet Connectivity to all 13693 Gram Panchayat with help of VSAT Technology

<table>
<thead>
<tr>
<th>Category</th>
<th>Availability for</th>
<th>Bandwidth Available</th>
<th>Total (in Mbps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>1300 Concurrent User</td>
<td>16 Kbps burstable up to 256 Kbps/site</td>
<td>22 Mbps</td>
</tr>
<tr>
<td>VoIP</td>
<td>200 Concurrent User</td>
<td>16 Kbps/site</td>
<td>3.2 Mbps</td>
</tr>
<tr>
<td>Video Conference</td>
<td>35 Channel</td>
<td>384 Kbps/Channel</td>
<td>13.5 Mbps</td>
</tr>
<tr>
<td>Video Broadcast</td>
<td>1 Channel</td>
<td>4 Mbps</td>
<td>4 Mbps</td>
</tr>
</tbody>
</table>

On 7th October 2008, Bandwidth was released
On 21st November 2008, Network Management Policy Implemented
Monthly Progressive Report of eGCI

VSAT Deployment

- Feb-08: 3000
- Mar-08: 6461
- Apr-08: 7600
- May-08: 9691
- Jun-08: 11387
- Jul-08: 13693

Page 49 September 2009
Network Architecture of eGCI Project
Service Provider: Airtel

MCU
Satellite
13693 Remote Location
VoIP Internet Intranet
Video Broadcast
Video Conference

Airtel Hub & Egram NOC
District Collectorate - Jan Sewa Kendra

► Basic Services
► Process
  ► Form Issue
  ► Form Fill up
  ► Form Submission
  ► Form Tracking
  ► Delivery
  ► Weekly Review
► Performance Highlights
► Impact
Jan-Seva Kendra – Basic Services

► Certificates: Domicile, Creamy layer /O.B.C., SC/ST, Income, Senior Citizen Certificate & etc.
► Affidavits: 52 types
► Land Revenue and Other Payments
► Ration Card-related processes
► One Day issues: 11 types. (Income Certificate, Senior Citizen Certificate, SC/ST, Domicile, Widow Certificate etc.)
► Non One Day issues: Land related matters, Weapons Licenses, Permits, Ration Card Related, etc.
► E-Stamping, True Copy
Jan-Seva Kendra – Process

Form Issue

- Forms easily available at Jan Seva Kendra, also available on choras, etc.
- Forms Downloadable from Internet (planned in future)
- No Charge for the forms.
- When form is submitted Rs. 20 is Charged, a receipt with barcode number is given & a unique Citizen id is created which can be used in future.
- List of Instructions, Enclosures, Time limit, Dept. / Office Name are Printed on the form
Jan-Seva Kendra – Process

Form Fill Up

► Simplified Forms with clear list of enclosures
► Help Desk: Retired Officers review applications before submission
  ► Free Service
  ► No touts / agents – major cost savings for citizens
► Partly Pre-filled forms for registered citizens on basis of Citizen ID or Finger-print
► All services available at a single stop
  ► Webcam for Instant Photos
  ► Franking Machine
  ► Attested Copies
Jan-Seva Kendra – Process

Form Submission

► Computer-assisted form acceptance
  ► Only Complete Applications accepted, No Queues
► All counters process all applications
► Computerized token system to guarantee minimum wait time to applicants.
  ► First come first served
  ► Optimal resource utilization
► Green channel for:
  ► Senior Citizens
  ► Physically challenge
► Operations Extended beyond Office Hours everyday whenever required.
► Bar coded receipt incl.:
  ► Latest delivery date/time
  ► Office / Department
Jan-Seva Kendra – Process

Track Form

► Officers can monitor the pendencies
  ► On their Computers
  ► using SMS
► Complete date-time Log of each stage of every application available by scanning Barcode

Delivery

► SMS Notification to applicant on completion
  ► Applicant can be sure of availability of documents
► Certified photocopies, laminated documents kept ready (Planned)
► Home Delivery if preferred for (This service additional fee of Rs. 5/- charged.)
► Before delivery of documents Bar coded receipt of applicant, photo ID used to verify citizen.
Jan-Seva Kendra – Process

Weekly Review
► Pendency & Lapses
► Analysis of feedback of citizens & officers
► Simplification of forms and processes
► Review of time limits
► Addition of new Issues
► Improvement of infrastructure
► Overlapping & Duplications removed
► Standardization of process reforms by issue of Office Orders
Jan-Seva Kendra – Performance Highlights

- >95% of 1,70,000+ applications completed in time
- 95% of over 5000 feedbacks overwhelmingly +ve
- Visit follow-ups reduced from >1000 to <20 per month
- Movement from One day to Tatkal (“while-U-wait”)
  - Service delivery time for affidavits reduced from few Hours to 20 Minutes
  - Service delivery time for one-day issues e.g. certificates reduced from few days to few Hours
- Queries due to incomplete applications reduced to <1%
Impact: In-Time Completion

![Graph showing In-Time Completion rates over months from May 2008 to July 2009. The graph includes data points for different months and categories: Oneday %, Non Oneday %, and Over All %. The data shows variability in completion rates with peaks and troughs across the months.](image-url)
AHMEDABAD
MUNICIPAL CORPORATION

E-GOVERNANCE

an initiative for
EASY GOVERNANCE

September 2009
Municipal Corporation – City Civic Centres

- Ahmedabad Municipal Corporation
- Services Provided
- E-Governance Impact
Ahmedabad Municipal Corporation (AMC)

Ahmedabad Municipal Corporation is the first Municipal Corporation in India to facilitate better performance of the delivery of municipal services through e-governance to the 36 Lacs citizens of the city.

Features of the project:

- Citizen can avail services from any counter in any of the centers
- Help Desk fully equipped with necessary documents, forms and other assistance
- Speedy delivery of services
- Trained operator for providing services
- Necessary provision of allied services
- Services can be provided beyond office hours
- No. of transactions from citizens increased by 5 times
- Tax collection increased from 38% in 2002 to 80% in 2007-08
Ahmedabad Municipal Corporation (AMC)

All offices will be connected via 2 Mbps lease line plus ISDN for back up line (Network of 1400 Computers on WAN)
AMC – Services

► Property Tax
► Vehicle Tax
► Building Plan Approval
► Issuance of Birth & Death Certificates
► Registration of Birth and Death
► Shops and Establishment Licenses
► Registration of Complaints – Ward level connectivity
► Online Tenders
► Hawker License
► Restaurant License
► Right to Information
► Water Connection
E-Governance Impact

- No. of services increased from 3 to 10
- No. of users increased from approx 2 Lacs to 10 Lacs
- In the last 7 years, 53.77 lakh citizens visited civic centres and 19.02 lac people have visited the AMC website (www.egovamc.com)

<table>
<thead>
<tr>
<th>REVENUE TYPE</th>
<th>2002-03</th>
<th></th>
<th>2007-08</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>NO. OF RECEIPTS</td>
<td>COLLECTION</td>
<td>NO. OF RECEIPTS</td>
<td>COLLECTION</td>
</tr>
<tr>
<td>Property Tax</td>
<td>1,75,949</td>
<td>64,70,77,813</td>
<td>8,43,045</td>
<td>2,69,22,79,195</td>
</tr>
<tr>
<td>Vehicle Tax</td>
<td>13,443</td>
<td>89,37,112</td>
<td>30,109</td>
<td>2,05,79,160</td>
</tr>
<tr>
<td>Building Plan</td>
<td>0</td>
<td>0</td>
<td>2,473</td>
<td>36,24,84,846</td>
</tr>
<tr>
<td>TDO Fees</td>
<td>0</td>
<td>0</td>
<td>2,933</td>
<td>13,48,42,331</td>
</tr>
<tr>
<td>Shops</td>
<td>8,599</td>
<td>6,04,829</td>
<td>25,567</td>
<td>29,98,947</td>
</tr>
<tr>
<td>B/D Cert</td>
<td>0</td>
<td>0</td>
<td>73,928</td>
<td>30,16,175</td>
</tr>
<tr>
<td>Hawkers License</td>
<td>0</td>
<td>0</td>
<td>252</td>
<td>1,19,925</td>
</tr>
<tr>
<td>Hotels &amp; Restaurants</td>
<td>0</td>
<td>0</td>
<td>359</td>
<td>4,39,900</td>
</tr>
<tr>
<td>Right to Information</td>
<td>0</td>
<td>0</td>
<td>4,081</td>
<td>65,700</td>
</tr>
<tr>
<td>Professional Tax</td>
<td>0</td>
<td>0</td>
<td>91504</td>
<td>33,54,66,893</td>
</tr>
<tr>
<td><strong>TOTALS</strong></td>
<td><strong>1,97,991</strong></td>
<td><strong>65,66,19,754</strong></td>
<td><strong>9,82,747</strong></td>
<td><strong>321,68,26,179</strong></td>
</tr>
</tbody>
</table>
Impact of the project

- No. of Citizens paying taxes increased from 38% to 72%
- This amounts to increase in revenue by more than Rs. 100 Crores
- Citizen pays taxes because now he/she knows that Services are better
Department of Health Emergency Management and Research Institute (EMRI)

September 2009
GVK EMRI (Emergency Management and Research Institute) is a pioneer in Emergency Management Services in India.

GVK EMRI handles medical, police and fire emergencies through the "1-0-8 Emergency service". This is a free service delivered through state-of-art emergency call response centres and has over 1900 ambulances across Andhra Pradesh, Gujarat, Uttarakhand, Goa, Chennai, Rajasthan, Karnataka, Assam Meghalaya and Madhya Pradesh.

**In Gujarat**

108 services were launched in Gujarat on the 29th of August 2007. GVK EMRI started its operations with 15 ambulances covering Ahmedabad and Gandhinagar. Currently, 108 services are available across entire Gujarat covering all 26 districts and 5.07 crore population with a fleet of over 400 ambulances and has handled over 5 lakh emergency calls till date.
Department of Police
Integrated Police Management System
Department of Police – Integrated Police Management System

► Vision
► Objectives
► Integrated IT Solutions
Vision

“To create a dynamic world-class model police organization by providing innovative IT solutions that would not only facilitate law enforcement for community safety but would also aim to build crime and criminal information database for effective crime control and deliver quality citizen centric services in a proactive and efficient manner and address needs of citizen, police administration Government agencies (immigration control, embassies, hospital, passport, courts) Governments and Crime prevention, detection, and investigating agencies by providing cross cutting information.”

Major Modules

Integrated Crime & Criminal Information System

HoD modules

Administrative Management System (HRMS, ESS, Payroll, Inventory)

Citizen Portal
Objectives

► To build centralized repository for crimes, criminals and organized criminal gangs
► To help the Home Department to improve upon their existing processes for effective administration through re-engineering of processes.
► To provide best-in-class citizen centric services and eventually bring all the G2G, G2C and G2B services within the purview of Home Department so as to obviate the need for citizens and business people to visit the Department’s offices.
► To build up a central repository of various records, their analysis and publishing of reports catering to needs of government agencies.
► To provide Innovative business solutions with integrated approach for world-class, state-in-art technologies such as Face, Fingerprint and IRIS Recognition.
Home Department- Integrated IT Solutions
Department of Planning
Flagship and Mission Mode Projects
Department of Planning

Flagship projects
- 30 (now 41 in 2009) Developing Talukas
- Vanbandhu Kalyan Yojana
- Sagarkhedu Sarvangi Vikas Yojana
- Garib Samruddhi Yojana

Mission Mode projects
- Kanya Kelavani
- Krishi Rath
- Nirmal Gujarat
- Nirogi Bal
- Skill Development
- Livelihood
- Nutrition Mission (Proposed)
Critical Issues in Development Planning and Human Development

- Issues of backward pockets in the context of balanced growth
- Issues of slow pace of regional development due to geographical considerations like hilly (tribal) regions, coastal regions, arid regions, etc.
- Issues posed by rapid urbanization-pressure on cities and proliferation of towns/municipalities
- Issues of human development-economic growth does not provide all the solutions
  - Education-specially primary and girl child
  - Health-access and quality
  - Nutrition
  - Women-Adverse sex ratio and empowerment
  - Basic amenities like water, sanitation and electrification
  - Livelihood- empowering young people with skills and training for employment
Flagship Programmes

- Flagship Programmes address to a variety of issues, involve multiple departments and address the developmental problem spread over specific geographical areas/regions
- The programmes focus both on people as well as infrastructure
- Human development is a crucial component
  - Vanbandhu Kalyan Yojana (2007)
  - Sagarkhedu Sarvangi Vikas Yojana (2007)
  - Garib Samruddhi Yojana (2007)
Flagship Programmes


► This programme included 30 talukas identified on the basis of 44 socio-economic indicators and are categorized by features like lack of industrial development, poor infrastructure and agriculture productivity and remoteness.

► In addition 11 talukas which are weak in human development indicators have been selected.

► 41 talukas have voluntarily been adopted by officers in the rank of Secretaries and above who prepare a vision statement and development strategy for the development of the taluka and provide leadership and guidance in decided priorities and allocations.

► Each officer is provided with a discretionary allocation of Rs 2 crores per annum, in addition to the regular provision of various schemes under different departments and Panchayati Raj institutions.
Flagship Programmes

Vanbandhu Kalyan Yojana (2007)

- Chief Minister’s Ten Point Programme for the Development of Tribal Areas (Vanbandhu Kalyan Yojana) in 2007
- One of the biggest and the most comprehensive projects dedicated to tribal development in India
- Programme is implemented in 43 talukas of 11 districts in the State
- Seeks to enable the tribal regions to leapfrog into mainstream development by bridging the gap between ITDP blocks and other parts of Gujarat
- The Ten Point Programme will allocate a package of Rs. 15,000 crores - the largest in the state’s history of tribal development
- Programme with lead tribal communities into the new age of global linkages, IT, and value addition

<table>
<thead>
<tr>
<th>Ten Point Programme</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Employment Opportunities for 5 Lakh Families</td>
</tr>
<tr>
<td>2. Quality of Education and Higher Education</td>
</tr>
<tr>
<td>3. Economic Development</td>
</tr>
<tr>
<td>4. Health</td>
</tr>
<tr>
<td>5. Housing</td>
</tr>
<tr>
<td>6. Safe Drinking Water</td>
</tr>
<tr>
<td>7. Irrigation</td>
</tr>
<tr>
<td>8. Universal Electrification</td>
</tr>
<tr>
<td>9. All-Weather Road Connectivity</td>
</tr>
<tr>
<td>10. Urban Development</td>
</tr>
</tbody>
</table>
Flagship Programmes

Sagarkhedu Sarvangi Vikas Yojana (2007)

- Program amounting to Rs. 11,000 crore focuses on the developmental issues of 60 lakh population living in 3000 villages of 38 coastal talukas in 13 districts
- Addresses special problems to improve quality of life at coastal areas in Gujarat, especially fishermen population
- Programme focuses on:
  - Capacity building and training for upgradation of skills in a big way
  - Tourism activities would be initiated with a view to increase related employment
  - Specific and time bound action plan for improving wage and self-employment, educational facilities, health infrastructure, drinking water, electrification and water conservation
  - Upgradation of technology in traditional professions like fishing as well as salt workers
  - Issues of coastal security

<table>
<thead>
<tr>
<th>Twelve Point Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Skill Upgradation Programmes</td>
</tr>
<tr>
<td>2. Creating Employment Opportunities</td>
</tr>
<tr>
<td>3. Development through Education</td>
</tr>
<tr>
<td>4. Health services for all</td>
</tr>
<tr>
<td>5. Access to Pure drinking water</td>
</tr>
<tr>
<td>6. Home for all</td>
</tr>
<tr>
<td>7. Soil conservation</td>
</tr>
<tr>
<td>8. Water Management</td>
</tr>
<tr>
<td>9. Electrification</td>
</tr>
<tr>
<td>10. Capacity Building Programmes</td>
</tr>
<tr>
<td>11. Development of Salt Pan Workers (&quot;Agarias&quot;)</td>
</tr>
<tr>
<td>12. National Security</td>
</tr>
</tbody>
</table>
Flagship Programmes

Garib Samruddhi Yojana (2007)

- Hon. Chief Minister had announced a Rs.13000 crore Programme for prosperity of 50 lakh urban poor families called “Garib Samruddhi Yojana” in 2007
- This programme is a holistic endeavor to translate dreams of urban poor into realities
- It is an all inclusive and integrated development effort of the Government of Gujarat, which also attempts to ensure slum free towns and cities
- This multiple result-oriented programme focuses on permanent employment, health, education, housing, roads, power and other services and the efficient availability and delivery thereof
- The programme includes vocational training for skill formation to equip urban youth to find employment
- It envisages extending basic health facilities in urban areas with focus on the urban poor
Mission Mode Programmes

- Mission Mode Programmes address a specific problem, are generally departmental specific and address a common problem across the State.
- There are 6 programmes in Mission Mode in addition to 4 Flagship Programmes.

<table>
<thead>
<tr>
<th>No.</th>
<th>Programme</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Kanya Kelavani</td>
<td>Education Department</td>
</tr>
<tr>
<td>2</td>
<td>Krishi Rath</td>
<td>Agriculture Department</td>
</tr>
<tr>
<td>3</td>
<td>Nirmal Gujarat</td>
<td>Urban Development Department</td>
</tr>
<tr>
<td>4</td>
<td>Nirogi Bal</td>
<td>Health Department</td>
</tr>
<tr>
<td>5</td>
<td>Skill Development (New)</td>
<td>Education Department</td>
</tr>
<tr>
<td>6</td>
<td>Livelihood (New)</td>
<td>Rural Development Department</td>
</tr>
<tr>
<td>7</td>
<td>Nutrition Mission (Proposed)*</td>
<td></td>
</tr>
</tbody>
</table>

- 2 new missions were launched for ensuring convergence across departments/agencies and by focusing on specific target groups which includes the informal sector.
Mission Mode Programmes

Kanya Kelavani

► Kanya Kelavani is organized since last 6 years in all villages as well as in urban areas of the State
► To enroll all children particularly in Primary schools
► Kanya Kelavani Rath Yatra is celebrated every year at opening time of the schools for three days (Praveshotsav)
► Hon. Chief Minister, Hon. Ministers and all officers visit villages and motivate parents to enroll their children, particularly girls in school
► Remarkable decrease in dropout rate
► In the year 2000-01, dropout rate was 20.93% in Standard 1 to 5, which is reduced up to 2.29% in the year 2008-09 where as dropout rate was 38.92% in Standard 1 to 7 is reduced up to 8.87%
► An enrolment rate as high about 99 percent has been achieved
► From this year, emphasis is being focused on quality aspects and apart from the Praveshotsav a “Gunotsava” is being started in November-December
► Attention is also being given to secondary education with Secretaries adopting poor performing schools
Mission Mode Programmes

Krishi Rath

- Krushi Mahotsav, as an intensive convergence and mass contact strategy, was successfully tried during 2005 to 2008
- From this year the programme is continued as an intensive extension programme through Modified Krushi Mahotsav - Kharif-2009 - Kharif campaign
- Programme has been organized over three days to include Krushi Mela, Krushi Exhibition, Seminar etc.
- Soil Health Cards have been provided to 17.37 lakh farmers - use of Soil Health Card has been a great success and is now institutionalized
- The value of Gujarat’s total agricultural production including animal husbandry and horticultural production, Rs.18,104 crore in 2002-2003 has risen to an estimated value of about Rs.49,036 crore at current prices in the year 2007-08
- Gujarat’s agricultural growth rate during the last four years has been very high—of the order of nearly 12 percent per annum
- There has been a 20% increase in milk production; because of Krishi Mahotsav
Mission Mode Programmes

Nirmal Gujarat (Clean Gujarat)

- Holistic and integrated thrust to ensuring clean land, clean water and clean air in the state
- Public awareness through Campaigns
- Generating an overall culture of awareness-propelled-action by the citizens
- Incentives for collection of safai tax
- Energy Conservation through energy audit and efficient equipment
- Infrastructure development for gas and electricity based crematorium
- Provision of low cost individual toilets
- Women’s empowerment and strengthening of Sakhi Mandals
- State Government has banned the use of plastic below 20 microns and reusable cloth bags are promoted as its alternative
Mission Mode Programmes

Nirogi Bal Varsh

► Launched by Govt. of Gujarat as an initiative to achieve improved health of mothers and children for improvement in overall human development index of the State

Salient Features of Nirogi Bal Varsh

➢ Interdepartmental Convergence
➢ Care of the mother
➢ Addressing malnutrition and unmet need for Family Planning
➢ Right of the Girl child to be born
➢ School health

Activities during Nirogi Bal Varsh

➢ Mamta Abhiyan for improvement of maternal and child health
➢ Ensure Neonatal care by Bal Sakha Yojna, Emergency newborn Care Training
➢ Ensure improved institutional delivery by Chiranjeevi Yojna, linkages with 108
➢ Addressing adolescent health through Adolescent Reproductive and Sexual Health Centres and Mamta Taruni Abhiyan
➢ State Health & Nutrition Cell
➢ Improving sex Ratio by Beti Bachao Andolan
Mission Mode Programmes

Skill Development (New)

► Several government departments/agencies impart vocational training as well as formal education to the youth to prepare them for the job market

► There is often an overlap between agencies, objectives of training as well as target groups

► There is also a mismatch between the skills imparted and the skills required by the secondary and tertiary sectors

► Mission has been launched to address these issues and to develop a multi-pronged and well conceived strategy to equip youth with the skills required by the potential employers

<table>
<thead>
<tr>
<th>Key Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>► Setting up new ITIs</td>
</tr>
<tr>
<td>► Revamping courses</td>
</tr>
<tr>
<td>► Starting new courses</td>
</tr>
<tr>
<td>► Conducting short term courses in Modular Employable Skills</td>
</tr>
<tr>
<td>► Special <em>Umeed</em> initiative for the tertiary sector including customer relations, marketing and maintenance aspects of the secondary sector</td>
</tr>
<tr>
<td>► SCOPE project to increase employment opportunities by providing training of English to youth in the age group of 15 to 35 with a provision of Rs.5 crore.</td>
</tr>
<tr>
<td>► Optimal use of existing capacities for skill development</td>
</tr>
</tbody>
</table>

* Petroleum University is already started with a capacity of 1000 students & introduction of a new course on Nuclear Energy
Mission Mode Programmes
Livelihood (New) - “Mission Mangalam”

- Aimed at achieving Convergence in Livelihood and Poverty Eradication schemes implemented by multiple agencies reporting to different departments often targeting the same group of beneficiaries

- Problems in rural areas are distinct from problems in urban areas which have to tackle issues of expansion along with pressures of migration

- Unique initiative by Gujarat

- Target-based approach rather than Diagnostic-approach

**Planned Outcomes**

- 250,000 Sakhi Mandals /SHG-s to be formed / strengthened, covering 30 lakh households, of which at least 10 lakh will be BPL

- 20,000 Producer Groups to be formed covering 10 lakh households to provide access to Agriculture, Livestock and Non-Farm Business and support services for income enhancement

- Form over 1,000 Cluster Federations followed by Taluka, District and State Federations of Sakhi Mandals / Producer Groups to create “market empowerment”
Mission Mode Programmes

Nutrition Mission (Proposed)

► State to set up a State Task Force for Nutrition under Chairmanship of PS (Health)
► District Task Force would be set up under Chairmanship of District Collector
► 51 CDNC Centers to be set up for malnourished children in all districts
► Fortified and Protein enriched atta to be supplied for Anganwadis & MDM
► Special integrated nutrition programmes in 12 tribal districts
  ➢ Universal screening and treatment of Anemia of pregnant and lactating mothers
  ➢ Nutrition Supplementation for Tribal and BPL mothers by Cash assistance of Rs 2000 to pregnant and lactating mothers
Other Key Initiatives in Human Development

► “Chiranjeevi Yojana” to reduce both infant and maternal mortality through institutional deliveries
► EMRI 108 services across the State and also catering to safe child births
► "Beti Bachavo Abhiyan" to improve sex ratio and decrease sex discrimination
► “Special School Health Checkup Programme” which covers 1.36 crore children of the State
► Kanya Kelavani Niddhis and Vidya Laxmi Bonds as incentive to parents of girl child
► Fortification of atta provided to antyodaya and BPL families
► Double fortification of atta with micro-nutrients and proteins under MDM and Anganwadis
Integrated Financial Management System (IFMS)

Finance Department
Government of Gujarat

September 2009
Department of Finance – Integrated Finance Management System

► Stakeholders
► Services
► Other GOG Framework Integration Functions
► Govt. Process Re-engineering/Improvements
► Key Features / Benefits
Integrated Financial Management System (IFMS) is a tool which will provide:

- Real time financial position of the State by on-line updation and consolidation of Receipts and Expenditures to help effective and efficient monitoring and control:
  - By efficient management of funds,
  - By monitoring and controlling government liabilities
  - By monitoring ways and means position

Provides Real Time Financial Position
Stakeholders

**Finance Department**
- Budget
- Treasury
- Pension
- Debt Management

**Planning Department**
- Annual Development Plan
- Plan Scheme Monitoring and Tracking

**Admin. Departments**
- Expenditure Management
- Plan-Non-plan budget Utilization

**AG Office**
- Audit - Voucher level
- Generation of Finance and Civil Accounts

**Drawing and Disbursement Officer**
- Bill Preparation and submission
- Monitoring and controlling Grant

**Banks**
- Collection of Taxes through Challan
- Payment against Advice

**Employees**
- Reimbursement claims
- Advances and Loans
- Pay Fixation
- Pay verification

**RBI**
- Ways and Means
- Overdraft
- Govt. Investments

**IFMS**
IFMS-Other GOG Framework Integration

Cyber Treasury
- VAT/CST
- Motor Vehicle Tax
- Electricity Duty
- Entertainment Tax
- Luxury Tax
- Entry Tax
- Stamp Duty
- Prohibition & Excise

Framework
- VATIS
- IWDMS
- Employee Services
  - Reimbursements
  - Loans & Advances
  - Pay Fixation
  - PF Withdrawal

Other Departments Frameworks (HMIS, Police etc.)

Cyber Treasury/ Business
- Registration
- e-Return
- e-Payment
- Notices
- Alerts & Notifications

Citizen

Employee

Page 97 September 2009
IFMS Functions

**ADP**
- Receiption and Payment details
- Finance Accounts and Civil Accounts

**AG System**
- Receipt and Payment details (vouchers/challans)
- Finance Accounts and Civil Accounts

**Bank**
- Revenue collections and Payment details
- Payment advice

**RBI**
- Ways and means position
- Overdraft detail

**Tax System**
- Tax Collection details for Reconciliation

**Citizen/Portal**
- e-Payment details regarding tax payment
- Citizen specific services

---

**IFMS Application Modules**

**DSS & MIS**

**DMO Cell**

**Pay Fixation**

**Budget**

**Grant**

**DDO Functions**

**Pension Functions**

**Treasury Functions**

---

**External Interfaces**
Govt. Process Re-engineering/Improvements

IFMS

► Online Bill Processing and Submission using Digital signature
► Cyber Treasury-Online Payment of Taxes/dues
► Electronic Pension Payment Processing using ECS facility
► Electronic Reconciliation of Accounts with AG
► Standardization of Accounting processes of State and AG
► Facility of electronic scroll upload and automatic reconciliation
► Electronic Interface with RBI and Banks

VATIS

► Time limits introduced for VAT processes like registration, refund etc.
► Simplifying return forms
► Provisions for lump sum tax
► Grievances redressal forum introduced
► Self assessment for more than 85% dealer who file regular returns.
Key Features / Benefits

- Integrated solution offering a Single Window Interface across various functions viz.
  - FD, Budget, Dir. Treasury and Accounts,
  - Dir of Pension,
  - Treasuries, sub treasuries,
  - DDO with exchange of data with external entities like AGO, RBI, Banks, Insurance & PF
  - Other Government departments and offering single access point to IFMS users
- Real time financial position of state finances by on-line updation and consolidation of Receipts & Payments
- Online & Real-time generation of Budget Publication with no errata
- Single Treasury solution resulting into transparent & consistent view of all treasuries across the state
- Decision Support System & exhaustive MIS for FD, DTA, DPPF, DDO
- Context sensitive helps and guided workflows require little or no training to new employees
- Easy analysis / prioritization of bills by amount and type of bill
- One time data capture/entry at source
- Robust history / tracking of bills
- Effective and improved delivery of services to citizens
- Multiple delivery channels (like internet, intranet, SMS, email) capable solution
Key Features / Benefits (Contd.)

**All Administrative Departments will be able to:**
- Track total expenditure incurred at a given point of time against estimated budget and total Grant allocated for that period
- Track and Monitor Plan / Non Plan Expenditure respectively
- Track and Monitor Centrally Sponsored Scheme details
- Monitor Major Head wise and Scheme wise details of Plan/Non Plan Expenditures
- Get total grant utilization report (Department wise Used/Unused grant)
- Monitor Controlling Officer (CO) and Drawing and Disbursement Officer (DDO) wise Grant utilization and Expenditure details

**Technical Benefits**
- Solution developed based on the open standards – J2EE which provides better performance, reliability, security, and scalability
- Solution is platform and database independent
- Layered security control and services covering identification, authentication, authorization, administration and audit
- Readily available information with 24x7 access
- Highly scalable to any number of users with sufficient hardware resources
- Flexible Architecture allowing phased and modular deployment (integrated yet can be decoupled/modular)
BISAG - Bhaskaracharya Institute For Space Applications and Geo-Informatics
BISAG - Bhaskaracharya Institute For Space Applications and Geo-Informatics

- BISAG is a State level nodal agency to facilitate the use of spatial and geo-spatial technologies for the planning and developmental activities pertaining to Agriculture, Land and Water Resource Management, Wasteland/ Watershed Development, Forestry, Disaster Management, Infrastructure and Education.

Objectives:

- To setup a State Natural Resource Management System (SNRMS).
- To develop approaches for integrated resources data management.
- To promote the use of SATCOM networks for distant interactive training and education in the State.
- To provide services/consultancy based on specific user needs in the field of Remote Sensing and GIS.
- To provide wider usage of geo-spatial applications through simultaneous support systems / software to concurrent users.
Activities:

► Development, processing and provisioning of Geo informatics data, applications and decision support system

► Organising and conducting academic courses in area of Geo informatics

► Provisioning satellite communication services for promotion and facilitation of interactive training, education and extension
Key Learnings

Effective resource mobilization

► The state has allowed its urban local bodies to impose various taxes such as property tax, water tax, sewerage tax, professional tax, vehicle tax etc. to enable them raise necessary resources for providing high quality services to the citizen. Similarly the rural local bodies have also been empowered to impose and collect taxes.

Design flagship programmes and mission mode schemes

► State level Flagship Programmes and Mission Mode schemes mark a paradigm shift in governance.

► It questions existing hierarchies and departmental controlled mechanisms which have existed for years.

Convergence

► Successful implementation has to go beyond mere co-ordination between departments.

► Proactive governance requires proactive convergence, not merely effective co-ordination.
Key Learnings

Monitoring

► Monitoring systems need to be developed which are IT enabled and web based, which requires development of new skills as well as attitudes
► Designing policies, implementation strategies and monitoring systems calls for inducting fresh blood at different lateral levels within the existing hierarchies
► Concurrent monitoring and evaluation by third party/well qualified consultants becomes critical in evaluation of success and failure as well as in effecting mid-term corrections

Enterprise wide IT solutions

► With rising popular expectations, quick response and prompt service delivery is required. It will require integrating the citizen centric delivery processes with the efficiency in internal processes within the Government. Enterprise wide IT solutions are required to be deployed to automate the backend are urgently required
Key Learnings

**Transparent and apolitical administration**

- Transparent administration is not only a desirable objective, but is necessary with high level of citizen awareness who are increasingly intolerant of deviant behavior and corrupt practices.
- Political intervention is necessary to envision the programmes and policies and for imparting necessary drive but political interferences needs to be avoided.
- The state bureaucracy must own the programmes and policies to ensure effective implementation of the same.
Way Forward

► Detailed study of the initiatives by respective departments for replication in the state
► Empowered committee to approve the blue print, roadmap and design of initiatives
► Implementation committee to ensure fast track implementation of initiatives
► Delivery monitoring unit (DMU) to monitor the implementation
► Regular reporting and review by Chief Secretary, Deputy. Chief Minister and Chief Minister
Thank You